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Blackboard Accounts

Blackboard accounts are used to access ECSU's online course management system.

IMPORTANT NOTE: If you've had your password reset by ITS, you may be able to access email with the default password they give you, but it will not work in Blackboard
until you reset your password to only something you know.

Blackboard uses the Technology Account which is the same username and password as email and computer accounts.
To change passwords refer to Article 20: Student Technology Accounts or Article 32 Faculty/Staff Technology Accounts.

If you encounter errors please make sure of the following:

Your using the same username you use for Eastern email and Lab computers.
Please use all lowercase letters for the username only.
Type your password exactly as you would for Eastern email and lab computers.
You must have logged in to your Eastern email or an Eastern computer at least once before using Blackboard . If you have not done this your account will not be activated and
you will not be able to get into Blackboard .
If you are unable to log on to Blackboard, but see no error messages, check to see if you have a pop-up blocker installed and running. Pop-up blocking software is not compatible
with Blackboard and must be disabled. If your computer has a pop-up blocker enabled, please consult the documentation for the pop-up blocker for information on how to disable
it.

If you are sure you are doing everything right and you still can't log in, then it's likely that your password is expired. See Article 31 Blackboard Incorrect Username and Password Error  for
a detailed explanation and Article 20: Student Technology Accounts or Article 32 Faculty/Staff Technology Accounts for instructions for reactivating the account.
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Blackboard Issues

Blackboard Issues

Some people are experiencing an issue with Blackboard mail and other features of Blackboard. These problems are typically related to the Java plugin. Java is specific to individual
machines and may or may not be installed on your machine.

Can't Log In:

Your Blackboard username is the same username you use for Eastern email and Lab computers.
Please use all lowercase letters for the Blackboard username.
Type your password exactly as you would for Eastern email and lab computers.
You must have logged in to your Eastern email or an Eastern Lab Computer at least once before using Blackboard. If you have not done this your account will not be activated
and you will not be able to get into Blackboard.
If you are unable to logon to Blackboard but see no error messages, check to see if you have a "pop-up blocker" installed and running. Pop-up blocking software is not compatible
with Blackboard and must be disabled. If your computer has a pop-up blocker enabled, please consult the documentation for the pop-up blocker for information on how to disable
it.

Tool Errors:

Tool errors and errors with Blackboard features are caused by having the incorrect version of Java installed or by canceling or closing the  Java Security Warning popups when
they occur.
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Eastern Alert (Emergency Notification)

The Connecticut State Colleges and Universities Board of Regents has purchased an emergency notification system which utilizes an off-site service called Everbridge to provide quick
distribution of time-sensitive emergency messages to multiple devices selected by the subscriber (i.e. text messages, email, phone call, etc.). Eastern's emergency notification system is
called "Eastern Alert." The following document provides instructions on how to manage your account. Other information about Eastern Alert can be found
at https://www.easternct.edu/emergency-alerts/faq.html.
 

How to access?

The easiest way to access Eastern Alert is to use the link below:

Eastern Alert Portal  - Click "Sign in with SSO" (you may be prompted to log into Office 365). 

You can also access Eastern Alert by searching for the "Eastern Alert" app under All Apps in Microsoft 365. Further instruction for accessing Microsoft 365 Apps in article:
Accessing MS Office 365 apps. 

From within the portal, click "Sign in with SSO Credentials". If you are not already signed in, you will be prompted to sign in using your Eastern credentials.

Note: Sign in with Username & Password will not work. You must use Single Sign On. 

For issues signing in, call the Help Desk at (860)-465-4346 or see article: Password Management. 

To manage how you would like to receive alerts: 
Click on My Profile (Edit).

Enter or modify the methods you wish to receive alerts. You can also include the email addresses and phone numbers of family and friends you would like to receive
the notifications.

Note: You cannot remove your Eastern email address but can remove any other contact information you added, including phone numbers.

Click Save.

If you encounter any problems, don't hesitate to contact the Help Desk at helpdesk@easternct.edu or call (860)-465-4346.
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General Help Desk and Desktop Support Services Information

General Help Desk and Desktop Support Services Information

The goal of the Help Desk is to provide faculty and staff with timely, effective support for desktop computer hardware and software.  We offer assistance with office PCs, monitors,
printers, and other peripheral equipment.  Resident students who have questions related to the use of personally-owned computers on our campus network (ResNet) are also encouraged
to contact the Help Desk.

Help Desk staff can be reached at 860-465-4346 (465-4346) during regular business hours or via email at helpdesk@easternct.edu.  

The Help Desk is staffed from  8:00 a.m. to 5:00 p.m. Monday through Friday, except on holidays.  
Limited support is available on most Saturdays by calling 860-465-4688.

When you call or email the Help Desk, please have detailed information available, including your location and phone number, a description of the problem or request, and the model and
type of equipment.

Services Offered:

Hardware installation
Operating system installation or upgrade
Application software installation and support
Hardware and software troubleshooting
Configuration of print and file services
Assistance with email services
ResNet support services (students)

Help Desk staff provide first-level support by phone.  If the problem or request requires an on-site visit, one of our desktop support staff will make arrangements to meet the caller at their
location.  
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Incident Handling: An Orderly Response to Unexpected Events

Incident Handling: An Orderly Response to Unexpected Events
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Logging into SelfService (eWeb)

Access Self Service (eWeb) by first logging into Office 365.
If you are getting an error login into eWeb go to article 688: Troubleshooting eWeb - Self-Service, https://easternct.makekb.com/entry/688/

Accessing from the O365 portal page:

Access SelfService (eWeb) through the Office 365 portal at: 
https://www.office.com/?auth=2&home=1
If you are prompted to sign in, use your Eastern email address as the username and your Eastern Email password (Do not use your Eastern ID and PIN)
In the center search bar type eWeb to find eWeb icon. Click on the SelfService (eWeb) icon.

It should automatically log you in to SelfService (eWeb) and present your with your information. For future ease of access, pin this icon to your launcher by clicking on the 3 dots to
the right of the icon and selecting Pin to launcher.

Accessing from any O365 online page (Outlook, OneDrive or any O365 page):

Click the Main Menu icon (looks like a waffle or grid) in the top most section 
On the resulting menu, click All Apps →
Scroll down until you find the SelfService (eWeb) icon
Click the SelfService (eWeb) icon, it should automatically log you in to Self Service (eWeb) and present your with your information. For future ease of access, pin this icon to your
launcher by clicking on the 3 dots to the right of the icon and selecting Pin to launcher.

NOTE: if you see null Setting Up... icons on the lower section of the O365 portal page, access SelfService (eWeb) using the Accessing from any O365 online page (Outlook, OneDrive
or any O365 page) instructions above.

If you are looking for the Class Schedule - Search Course Offerings  link that use to be available without logging in, you can now find that by logging in to SelfService (eWeb), or by going
to the Registrar's page (http://www.easternct.edu/registrar) and click on Course Offerings where you do not need to login.
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Online Help Desk Request

Online Help Desk Request

Online Help Desk requests can be made at https://myeasternct.sharepoint.com/sites/HelpDesk
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Printing Transcripts Banner

Printing Transcripts Banner
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Residential Computer Fact Sheet

Eastern Connecticut State University Residential Computing Fact Sheet

The ECSU residential computer network, better known as Resnet, provides network connectivity for all residential students.  Resnet is designed to be as reliable as is possible in
providing learning services plus office and building operation.  

Use a standard ethernet cable to connect your PC to Resnet.  Ethernet cables are available in Media 252 (no cost).

Personally owned computers must meet certain criteria to be given Internet access.  They must:

Have properly licensed and UPDATED operating systems and application software.
Be configured to receive automated operating system updates.
Have anti-virus software running that is configured to receive automated updates.
Not have peer to peer software, viruses, or spyware actively running.

When your PC is physically connected to the network and turned on, it will be checked to determine if it meets these requirements.  If the PC needs to be updated, directions will be
provided.  If you need more information about configuring your PC browse to http://help.easternct.edu where you will have access to software upgrades and instructions.

Until these criteria are met, access to the Internet will be blocked.  Local services from ECSU, such as E-mail and Blackboard Vista will remain available.

Personally owned computers that have active peer to peer applications, viruses, or spyware will be quarantined: browsing to any external web site will return a page explaining that the
PC is quarantined.  Please see the above Help Page for details and information about how to get out of quarantine.

Students are responsible for maintaining the configuration of their PC. ITS staff cannot repair or reconfigure personally owned computers.

Several network security tools are in use which helps provide enhanced reliability for Resnet.  There are a number of network gateway devices, such as Packeteer and Interspect that
screen for illegal applications or activities consistent with virus activity.  The Cisco Clean Access product enforces basic personal computer hygiene.  Anti Virus software is required,
which further enhances personal computer hygiene.  While these are common requirements in an enterprise computing environment, they may at first pose an obstacle for the home
user.  ECSU Information Technology Services (ITS)  is committed to helping the Resnet computer user succeed in this enterprise environment.

Local services such as the Blackboard Vista course management system, student E-mail, on-line course registration, anti-virus software, and directions for self-directed help are all
available online even when the PC is blocked or quarantined.
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Saving Word Documents as HTML for use in Blackboard

Saving Word Documents as HTML for use in Blackboard

Strange characters particularly questions marks throughout your document occur when you use MSWord to generate your HTML. When you choose Save as Web Page from your Word
document, the result is an HTML document that uses XML. Blackboard cannot handle the XML and fills your document with strange symbols like question marks. Formatting will also
vary when documents are saved this way.

To fix the problem we have four possible solutions. 

1. Resave the document as filtered HTML.
Go to the File Menu and choose Save As. 
Choose Web Page, Filtered.
This generates HTML without the XML. This should elimintate most of the problems.

2. If this does not help, you can remove the strange characters and reformat the document using either the HTML editor in Blackboard or you can use another HTML editor tool
such as Dreamweaver. Alternately, you can copy the content from word and paste into Notepad (PC) or Text Edit (Mac) and then copy it again from there and paste into
Blackboard. The pasting into Notepad or Text Edit strips the MS formating and creates plain text which you can edit in the Blackboard Text Editor.

3. The third option is to create a PDF instead of HTML. This will preserve all the formatting too. You can do that in Word by going to Save As PDF.
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Student Technology Accounts (Email, Computer Lab, Blackboard)

IMPORTANT NOTE: Computer accounts are not to be shared with other users; when evidence of account sharing is found, all parties involved will be considered to be in violation of this
policy. Please review  Article 223: ECSU Policy on Computer Use

All Eastern students have a Technology account automatically generated upon registration. This account is used for Computer Labs, Email, Blackboard, and other online services, though
not all online services. Your username must be typed completely in lowercase and passwords must be typed in whatever case is appropriate.

IMPORTANT NOTE: New and transfer students MUST log on to either a University-owned computer or their Eastern email accounts (from on or off-campus) before attempting to log on
to Blackboard.

How to determine Your Username, Password, and Email address:

Log on to E-Web Online Services. For E-Web instructions see Article 21: Logging in to E-Web: Online Services .
Once you have successfully logged onto E-Web, click on the Personal Information link.
Click on View/Update E-Mail Address(es). You should see your Eastern email address on the page.
The part of the email preceding the @ symbol is your username. This is often your last name and some part of your first name.
The default password is made of the following 7 characters:

First Character: $
Second Character: First initial of your username in CAPS.
The last 5 digits of your Eastern ID number from your ID card or acceptance letter.
Example: A student with the username Jones and Eastern ID of 10256789, their default password would be $J56789

The First time you use your default password it will tell you it's expired and you will be prompted to set a new password that only you know. Please refer to  Article 22: Password
Rules for details.

Password Change

To change your email password see Article 485: Password Management 

Alumni Accounts

After graduating, your account will be converted to Alumni status and granted only a Microsoft 365 mailbox license. This means that your OneDrive and other
application access will be removed once your degree is awarded. The degree evaluation/awarding process is handled by the Office of the Registrar and takes
place 1-2 months after your final grades have been submitted.

If you'd like to know more about your transition to Alumni status, you can reach the Office of the Registrar at registrar@easternct.edu
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Student Z-Drives To Be Retired

Eastern is retiring the current student network file shares, known as the Z: Drive. The new default file storage system will be Microsoft OneDrive for Business.  This move will not only
provide greater accessibility and more granular recovery, it significantly increases storage for each student by 20,000 times the current allocation. 

ITS will be changing all student data from the local Z: drives to Read Only, at which point students can copy files to OneDrive. 

Additional information will be emailed as students return to campus. The ITS Help Desk will be available to assist all students.

In addition, a series of short informational/tutorial videos on O365 OneDrive for Business is available at:

https://support.office.com/en-us/article/video-get-started-with-onedrive-work-or-school-b30da4eb-ddd2-44b6-943b-e6fbfc6b8dde

Some advantages of O365 OneDrive:

O365 integration provides online editing and collaboration tools for Microsoft Office documents 
OneDrive will have 5TB of storage, 20,000 times more than the current Z: Drive 
OneDrive stores documents of nearly any file type 
Files may be accessed from any location on any device via the Internet
Individual files may be shared with other Eastern students and/or faculty to allow for real-time collaboration/editing 
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SPSS License Renewal for Home Use

Home use licenses for SPSS expire at the end of December every year. To renew your license, contact helpdesk@easternct.edu for the current code and follow the instructions below.

Launch the License Authorization Wizard from the Programs or Applications Group on your Mac or PC.
On the Product Authorization screen, select License my Product Now.
Click Next.
Enter your Authorization code (you can copy and paste it). 

The License Authorization Wizard sends your authorization code over the Internet to IBM and automatically retrieves your license. This requires you to be online when you do this.
Firewalls may prevent successful licensing over the Internet.
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Spyware Issues

Spyware Issues

Spyware on your system can cause a variety of strange behaviors with Blackboard, Web surfing, and other applications. Below is a list of some behaviors we've seen. In each case the
solution is to do a full spyware scan. 

Spyware symptoms:

You attempt to access Blackboard or a page inside of Blackboard and get a You Are Not Authorized to View This Page error.
You attempt to access the Blackboard login page or entry page and you get redirected to someone else search page.
Browser Hijacking occurs when you attempt to reach a particular page and you are redirected somewhere else. Another symptom is when your default browser home page gets
changed without your knowledge.
Lot of popup advertising windows.
Your computer is runs increasingly slower. 
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What Computer Should I Buy?

Any brand Windows (Dell, HP, Lenovo) or Mac product will suit most user's needs at Eastern. If you have some experience with either Mac or PC, you should choose one you are
comfortable with, there's no need to add the stress of learning a new system with all the other new responsibilities you will have. Depending on specific software needs, for example
photo/video editing or data collection, the user may need to get a better processor or GPU. 

When using MS office and browsing the web, an i3 or i5 processor is enough with an onboard graphics card. We recommend having a minimum of 250GB worth of storage space and
8GB of RAM.

A heavy photo or video editing machine may require a dedicated GPU, along with 16GB of RAM and an i7 processor. Typically the software will label the minimum hardware
requirements needed, however it is the responsibility of the user to check for compatibility. 

We do not recommend Chromebooks or iPads as they run smart phone operating systems and aren't capable of all that a computer needs to do.

There is no need to buy MS Office Software, Eastern gives you MS Office at no cost. We also have a student IT Orientation site that lists some of the IT services and information you will
need to get started at Eastern.

Student IT Orientation:

https://myeasternct.sharepoint.com/sites/HelpDesk/SitePages/Student-Orientation.aspx
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On-Campus WiFi For Mobile Devices - Disable Private MAC Addresses

Note: This only applies to connecting to ECSU BYOD and BYOD5, the eduroam Wi-Fi signal does not require registration of a MAC address. See Article 180: Wireless Services for more
information on eduroam.

Recently both Apple and Google have released updates to the operating systems on their smartphones and tablets. These updates which randomize device MAC addresses
have caused major issues with mobile devices registered to use the campus Wi-Fi network. Students and faculty using smartphones and tablets have been unable to access the Internet
while on campus. The randomized MAC address option is configured for each wireless connection, so there is no way to configure this globally. The following instructions show how to
turn off the feature and once completed, the device should be able to access the campus Wi-Fi again.  

Disable Private MAC Address on iOS 14 - iPhones and iPads

If you are encountering connectivity issues on Eastern's wireless network after updating to iOS 14 or iPadOS 14, try disabling the "Private Address" feature, which randomizes MAC
addresses when joining Wi-Fi networks.

1. Open the Settings app, then go to "Wi-Fi"
2. Find the network you're connected to, then tap the  button next to the network name
3. Toggle the switch with Private Address to the OFF position
4. You may need to reboot your device

Disable MAC Address Randomization in Android 10

By default this MAC Randomizer will be enabled once the device is updated to Android 10. To disable it follow the steps below. You may have to enable Developer mode on the phone.
This is a secret menu that once enabled/unlocked allows you to access the option to disable the MAC Randomizer. The steps may differ depending on your brand. Multiple methods are
described below.

Method 1

1. Open the Settings app.
2. Select Network and Internet.
3. Select WiFi.
4. Select the gear icon next to the ECSU wifi connection.
5. Select Advanced.
6. Select Privacy.
7. Select Use device MAC

Method 2

1. Open Settings
2. Using search bar type in build
3. Select Build number. It will take you to the menu with this setting.
4. Select the Build number option 5-10x to unlock Developer options It may prompt for passcode
5. Go back to Settings
6. Using search bar type in Developer options
7. Select Developer options
8. Locate MAC Randomizer
9. Disable MAC Randomizer

10. Scroll up to the top and turn off Developer options This will hide those options

Method 3

1. Open Settings
2. Select About phone
3. Scroll down to Build number
4. Select the Build number option 5-10x to unlock Developer options It may prompt for passcode
5. Go back to Settings
6. Select System
7. Select Advanced
8. Select Developer options On Some phones it may now show Developer options directly on the settings menu.
9. Locate MAC Randomizer

10. Disable MAC Randomizer
11. Scroll up to the top and turn off Developer options This will hide those options

Method 4

1. Open Settings
2. Select About phone
3. Select Software information
4. Scroll down to Build number
5. Tap the Build number option 5-10x to unlock Developer options It may prompt for passcode
6. Go back to Settings
7. Select Developer options
8. Locate MAC Randomizer
9. Disable MAC Randomizer

10. Scroll up to the top and turn off Developer options This will hide those options
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Method 5

1. Open Settings
2. Select General
3. Select About phone
4. Select Software information
5. Scroll down to Build number
6. Tap the Build number option 5-10x to unlock Developer options It may prompt for passcode
7. Go back to Settings
8. Select General
9. Select Developer options

10. Locate MAC Randomizer
11. Disable MAC Randomizer
12. Scroll up to the top and turn off Developer options This will hide those options
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Browsing in Incognito Mode Guide

Browsing in Incognito Mode Guide

If you are running into error issues opening-up hyperlinks, it is advised to open the link in Incognito mode in Chrome, a Private window in Edge Chromium, or Firefox. The following link
contains information from LifewIre about How to Turn on Incognito Mode in Your Browser: https://www.lifewire.com/browsing-incognito-445990
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Work at Home Toolbox

Please select your Role:

Student

Faculty and Staff
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MS Access for Students

MS Access is a part of the Microsoft Office Suite. Students that need it on personal Windows machine can download it through their normal 0365 accounts. It will be included in the
download. 
All windows machines on campus have Access installed. 
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Accessing Blackboard

This article describes accessing Blackboard from the Eastern Connecticut State University website.

1. Go to https://www.easternct.edu/. Click on the hamburger in the upper right corner.

 
2. From the pop-out panel, click Current Students.

 
3. Click Email/Office 365 button.

Help
Desk

23

https://www.easternct.edu/


 
4. Click Eastern Apps.

 
5. Click the Blackboard button.

 
6. Enter your Eastern username and password.
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Residence Hall Services
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Cable/Internet Issues in Residence Halls

If you are having Cable or Internet issues in a residence hall room please try the following before contacting staff in your hall or ITS:

Internet:

Check your Internet jack and make sure it's pluged into the right port. Internet is the top port, the bottom is for phones.
Try your computer in another jack in your room. If it works, then the issue is with the jack and you should report it. If it doesn't work, the problem could be your device is not set up
properly or broken.

Cable:

Try your TV in another jack in your room. If it works then the issue is with the jack and you should report it. if it doesn't work, the problem could be your device is not set up
properly or broken.
Make sure you've programmed your TV to find channels here at Eastern. Instuctions to do so should be located in the manual or under the TVs menu.

If you still have trouble please collect the following information and contact the staff in your residence hall or the ITS help desk at 465-4346:

Your full name
Eastern ID number
Your room number
Bedroom number/letter if applicable
The internet jack number (located on the jack)
The best day and time to reach you (Monday through Friday 9 to 5)
Your cell phone number
A description of the problem you are having
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Cable Tv User Guide

ECSU Cable TV Service:

In 2014, Eastern's Charter Communications cable TV service was changed from an analog to an all-digital signal. This new service, which is free to students living in Eastern residence
halls includes an expanded channel lineup with many high-definition (HD) channels, four HBO channels, and over thirty digital music channels. This is a customized, bulk-feed type of
service that is specific to Eastern. The channels are fixed and the service cannot be upgraded with additional channels using Charter provided equipment.

To receive these channels, you must have a QAM tuner (Quadrature Amplitude Modulation). The QAM tuner allows your TV to receive high definition cable programming without a cable
set-top box. Most, but not all televisions manufactured after 2007 have an integrated tuner that can receive QAM based channels.

You should check the specifications from your TV manufacturer to determine if it includes the required QAM tuner. It should be explicitly referenced in the TV's specifications. There are
several types of digital tuners in the United States and not all will work with Eastern's cable TV service.

§  NTSC Tuner - not compatible,
§  ATSC Tuner - not compatible,
§  QAM Tuner - compatible and required.

Unfortunately, some less expensive TVs come with a low-quality QAM tuner that may not be able to pick up all of the digital channels. Our experience has demonstrated that well-
established manufacturers such as Samsung, Sony, Sharp, LG, and Toshiba have performed better. Also, to receive HD channels, you need an HD-compatible TV.

How do I program my TV to view the new channel lineup?  

Most QAM tuner TVs have a "Channel Search" or "Auto Program" function that will automatically scan the incoming signals and detect the ones that are available. It may be necessary to
do a channel search before your TV will allow you to tune to a specific channel.

1. Go into the TV Menu and select "Set Up"
2. Look for and select an option similar to "Channel Search" or "Auto Program"
3. The TV will automatically begin searching to identify all available channels
4. After this auto search is completed, there should be approximately 60-70 channels available for viewing (if the TV has an internal QAM tuner). If no channels are available,

it is likely the TV does not have a QAM tuner.

If you previously watched a program on channel 4, the new channel may have moved to a new number, such as 4.2 or 4-

Some TVs require you to erase "old" channels and rescan them in the new channels.

Also, most HD TVs have the ability to modify aspect ratios. If your picture seems stretched or has black bars around the picture after the scan, please modify the aspect ratio to fit with
your desired viewing experience.

If I do not have or do not want to purchase a TV with a QAM tuner do I have any other options?

You can purchase an external QAM tuner that can be connected to a TV. Only the following unit has been endorsed by Eastern and Charter Communications as being fully compatible
with the new cable TV service. This unit is available online directly through Channelmaster or from Amazon.

http://www.channelmasterstore.com/HD_Antenna_Tuner_CM_7001_p/cm-7001.htm

After consulting my TV user manual and verifying that I have a TV with a QAM tuner, I am still having problems getting a cable signal on my TV. What can I do for support?

Please contact the ITS Help Desk at 860-465-4346 or by email, helpdesk@easternct.edu.
 

Channel Name TV Channel Number

WFSB CBS HD 7.1

WVIT NBC HD 7.2

WCBV ABC HD 7.3

WCCT CW 8.1

WBZ CBS HD 8.2

WTNH ABC HD 8.3

WCTX MyTV HD 9.1

WUVN Univision HD 9.2

WTIC Fox Hartford 10.1

WEDH PBS Hartford 10.2

WGBH  PBS Boston 10.3

WHPX ION HD 11.1

NESN HD 11.2

WRDM-LP - Telemundo 12.104

Government Access 13.156
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Connecticut Public Affairs 15.97

ECSU Channel 22 16.105

Public Access 17.150

Charter TV 3 18.67

HBO HD 19.1

HBO 2  HD 19.2

HBO Signature HD 19.3

HBO Family HD 19.4

WCCT-DT - CW 20.1

This-TV 20.2

Comedy Central HD 22.17

A&E HD 23.17

WEDH PBS 24.1

Animal Planet HD 24.17

WEDH PBS CPTV4U 24.2

WEDH PBS CPTV Sports 24.3

Discovery HD 25.17

History Channel HD 26.17

National Geographic HD 27.17

Travel Channel HD 28.17

BET HD 29.17

Bravo HD 30.17

E! HD 31.17

Lifetime Movie Network 32.17

Esquire Network HD 33.17

TBS HD 34.133

TNT HD 35.174

USA HD 36.17

ABC Family HD 37.17

Cartoon Network -HD 38.17

Disney Channel HD 39.17

Nickelodeon-East HD 40.17

TV Land HD 41.17

Food Network HD 42.17

fx HD 43.17

Cloo TV SD 44.17

Channel Name TV Channel Number
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HGTV HD 45.17

Learning Channel HD 46.17

Spike TV HD 47.17

SyFy HD 48.17

TruTV - HD 49.17

Weather Channel HD 50.494

AMC HD 51.17

Turner Classic Movies 52.17

CMT 53.2

MTV HD 54.17

VH-1 HD 55.17

CNBC HD 56.17

CNN HD 57.17

CSPAN - HD 58.17

CSPAN2 59.211

Fox News Channel HD 60.17

HLN HD 61.17

MSNBC HD 62.17

EWTN 63.15

Home Shopping Network 64.17

Comcast SportsNet - HD 65.368

ESPN HD 66.173

ESPN2 HD 67.177

Golf HD 68.17

NBC Sports Net 69.131

Speed Channel HD 70.17

Music Channels 71.53 - 71.98

Channel Name TV Channel Number
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Connecting to Wifi at Eastern and Finding Your Mac Address

The instructions below relate to using ECSU BYOD5. If you are using eduroam, please see Article 180: Wireless Services. When you see a list of signals, you will see three (BYOD,
BYOD5, and Eduroam), we recommend BYOD5. The recommendation is based on the signal that has the best speed.

Any device with a standard input system (browser and keyboard) can connect to the campus wireless system and attempt to go to a web page. If the device is not registered, it will
redirect to the my devices page where you will be prompted to enter your username and password. The status will say pending, but the device will be automatically registered for Internet
use. Follow the steps below:

1. Select ECSU-BYOD5 from the list of available wireless networks. 
2. After connecting, navigate to http://easternct.edu and you will be redirected to the wireless sign-in page. 
3. At the sign-in menu, enter your Eastern username and password. Note: Your username is the part of your email address prior to @my.easternct.edu. 
4. Once successfully signed in, you will be redirected to a success page and granted access to the Wifi on your device for 365 days.

Devices that do not have standard input systems (game systems, TVS, etc.) need to be added to your My Devices list manually. The link to the portal is below followed by instructions for
determining the MAC Address required to add devices.

IMPORTANT NOTE: Accessing the network with either of the methods described above associates your username with that device. Any subsequent activity on that device is associated
with that username. Any activity in violation of Eastern's policies will be attributed to the username. Please use discretion when allowing others to use your devices.

IMPORTANT NOTE: My Devices registration of iOS devices require the device to be set to a static MAC address, see Article 638: Disable Private Mac Addresses 

My Devices Portal: 

https://mydevices.easternct.edu/mydevicesportal/PortalSetup.action?portal=1ad71200-5e4e-11e4-b905-005056bf2f0a

 

To register devices with no standard input system :

1. Navigate to the Current Students section of the Eastern homepage ( https://www.easternct.edu/portal/index.html) and locate the button labeled My Devices using your phone or
computer. Alternatively, scan the QR code below. 

 
2. Sign in using your Eastern username and password. 
3. Read and scroll through the Acceptable Use Policy.
4. Click Accept.
5. Click Continue.
6. Click Add.
7. Enter a Device Name and Device ID (MAC Address) It consists of 6 alphanumeric number pairs separated by colons such as AA:BB:CC:11:22:33. (see below for instructions on

finding your mac address)
8. Click submit.

Once submitted, the device registration process is complete, and the target device will have access to the ECSU-BYOD and ECSU-BYOD5 wireless networks. Note: The device
registration status may continue to say Pending, this does not impact your device's wireless access. 

Locating Your Device's Mac Address

The following instructions are to locate your device's MAC address. Every device has a unique identifier for its network adapters. This id is called the media access control address, or
MAC address. This 12 digit code is made up of letters and numbers and is usually separated by colons, periods or dashes.

Instructions here are provided to the best of our knowledge; because software and hardware instructions change without notice, when in doubt check your user manual or manufacturer's
website for support and instructions.

WINDOWS

1. Open the start menu and type, cmd. Click on cmd to open it in a new window.
2. Enter getmac into the window and press enter.
3. You should see your MAC address listed under Physical Address.

MAC OSX

1. In OSX, click on the Apple icon in the top left.
2. Open System Preferences, and select Network Preferences.
3. Select the connection type from the left. For wireless, select Wifi or Airport. For wired connections, select Ethernet.
4. Click on Advanced in the lower right corner.
5. Select the Hardware tab and the MAC address will be listed here.

APPLE IOS (iPhone, iPad, iTouch)

1. For iOS devices, open Settings.
2. Open the General menu.
3. Select About, scroll down to Wifi Address. Your device's MAC address is listed as Wifi Address.

ANDROID

For Android devices, note that these instructions may vary between Android versions and manufacturers.

1. From the Home screen, press Menu.
2. Select Settings.
3. Select About Phone or About Tablet. In some cases, you may have to select Wireless & Networks first, and check the box marked Wifi to turn the wireless on.
4. Select Status. For some versions, you may need to select Hardware Information instead.
5. Scroll down to the Wifi MAC Address field.

LINUX

1. Open a terminal or console window.
2. Type ifconfig.
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3. The MAC address will be listed as HWaddr in the format of 12:34:56:78:AB.

CHROMEBOOK

1. Open the Chrome browser.
2. 2. Enter chrome://system in the address field.
3. Expand the ifconfig field.
4. In the wlan0 section, you'll find the MAC address listed as Ethernet HWaddr.

KINDLE FIRE

1. From your home screen, tap your Settings icon.
2. Tap on More, and then tap on Device.
3. Scroll down to find the Wifi MAC Address section.

KINDLE, KINDLE TOUCH, AND KINDLE PAPERWHITE

1. Tap the Menu button from the Home screen.
2. Select Settings.
3. Tap the Menu button again.
4. Select Device Info.
5. Scroll down to find the Wifi MAC address.

BARNES AND NOBLE NOOK

1. Press the Home button.
2. Tap Settings.
3. Find the entry for MAC Address.

BARNES AND NOBLE NOOKCOLOR

1. Tap the Nav Arrow at the bottom of the screen to display the Quick Nav Bar.
2. Tap Settings then tap Device Info.
3. Tap About Your NOOKcolor.
4. Find the entry for MAC Address.

APPLE TV

1. Select Settings.
2. If you are using software version 1.x, select About. If you are using software version 2.0, select General, and then select About.
3. The MAC Address will be listed as either Wireless ID or Ethernet ID. a. You can also find both the Wireless ID and Ethernet ID on the UPC label on the bottom or back of the

Apple TV box, next to the serial number.

ROKU (NETFLIX) PLAYER

1. Select Settings.
2. Select About.
3. The Mac Address will be listed on-screen. a. You can also find the MAC addresses on the bottom or back of your Roku player.

TIVO

1. Press the TiVo button to go to TiVo Central.
2. Select Messages and Settings.
3. Select Phone and Network Setup.
4. The MAC address will be displayed at the top right-hand side of the screen.

BOXEE BOX

1. Select Settings.
2. Select System.
3. Select Information.
4. The MAC Address will be displayed on the screen.

BOXEE TV

1. Select Settings.
2. Select Network.
3. The MAC Address will be displayed on the screen.

GOOGLE TV

1. Select Settings.
2. Select Network.
3. Select Status.
4. The MAC Address will be displayed on the screen.

BLACKBERRY DEVICES

1. Select Options from the home screen, and then select Status.
2. Your MAC address will be listed in the WLAN MAC field. a. Not all BlackBerry devices have Wifi. 　

WEBOS DEVICES (PALM)

1. In the Launcher, scroll to the screen with the Device Info app and launch it.
2. Select More Info. (In some versions you will also need to select the Hardware tab.)
3. Your MAC address will be listed in the Wifi section.

WINDOWS MOBILE DEVICE

1. Make sure your Wifi is enabled.
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2. Select Start.
3. Select Settings, and then select Connections.
4. Select Wireless LAN and then select the Advanced Tab.
5. Your MAC address will be listed in the MAC field. a. Alternatively, your device may have the MAC address listed under Start>Settings>Wifi Manager>Advanced.

WINDOWS NOKIA LUMIA 900

1. Select Settings. Then, tap About and then tap More Info.
2. In the third tab, there will be a box for the MAC address.

WINDOWS PHONE

1. In the App List, tap Settings.
2. Tap About and then tap More Info.
3. The Mac Address will be listed on this screen.

NINTENDO DS (AND LITE VERSION)

1. Start a game that has Wifi capabilities.
2. Go to Settings.
3. Select the Nintendo Wifi Connection Setup. It could also be listed as Nintendo WFC Setup.
4. Select Options.
5. Select System Information.
6. Your MAC address will be displayed.

NINTENDO 3DS

1. Tap the wrench icon to access System Settings.
2. Tap Internet Settings.
3. Tap Other Information.
4. Tap Confirm Mac Address.
5. Your MAC address will be displayed on the screen.

SONY PSP

1. Turn on the PSP without a game in the system.
2. Press the Home button.
3. Press Settings.
4. Press System Settings.
5. Press System Information.
6. Your MAC address will be displayed.

SONY PS VITA

1. From the home screen, tap Settings.
2. Tap Start.
3. Scroll up and tap the System option.
4. Tap System Information.
5. Your MAC address will be displayed on the screen.

NINTENDO WII U

1. From the Wii U menu, select System Settings.
2. Use the left stick to select Internet and press the A button.
3. Select View Mac Address and wait for it to display.

MICROSOFT XBOX ONE

The first time turning on an Xbox One system requires an internet connection to reach the settings menu which is where you will find the wired MAC address you need to register your
device. The workaround for this is to allow the Xbox to run through the system setup, let it fail, select "Fix It" and then it will attempt to diagnose the issue. When that fails, it will bring you
to a screen prompting you to manually set up the connection, listing both the wireless and wired MAC address.

If you are able to reach the main menu on your Xbox, try the following to find the MAC Address.

1. Navigate to My Games and Apps.
2. Select Settings.
3. Select Network.
4. Select Advanced Settings.
5. The Wired and Wireless MAC address will be displayed to the right of your screen.

MICROSOFT XBOX 360

1. Select System from the Xbox Dashboard.
2. Select Network Settings.
3. Select Edit Settings.
4. Select Additional Settings.
5. Select Advanced Settings.
6. For Wired connections, your MAC address will be displayed under the heading Wired MAC Address. a. For Wireless connections, select Wireless Information. Your MAC address

will be displayed on this screen.

For the new NXE display

1. Go to My Xbox in the Xbox Dashboard.
2. Select System Settings, all the way to the right.
3. Select Network Settings.
4. Select Configure Network.
5. Under the Basic Settings tab, make sure IP Settings is on Automatic.
6. Go to the Additional Settings tab.
7. Select Advanced Settings.
8. The MAC address is displayed on the screen as Wired MAC Address.

NINTENDO WII
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1. From the Wii menu, choose Wii Options.
2. Select Wii Settings.
3. Click right to Wii System Settings 2.
4. Select Internet.
5. Select Console Information.
6. You will find your MAC address on this screen.

NINTENDO WII U

1. Go to System Settings.
2. Tap the Internet settings button.
3. Select View MAC Address.
4. Your MAC address will be displayed.

SONY PLAYSTATION 2 (SLIMLINE)

1. Turn on your PS2 with no game disc in the tray.
2. From the main screen, press the triangle button.
3. The MAC address will be listed on the System Information screen.

SONY PLAYSTATION 3

1. From the PS3 main menu, select Settings.
2. Select System Settings.
3. Select System Information.
4. Your MAC address will be displayed on the screen.

SONY PLAYSTATION 4

1. Select System.
2. Select System Information.
3. Your MAC address will be displayed on the screen.

TIME CAPSULE (APPLE)

1. The MAC addresses for both Ethernet and Wireless are found on the UPC label on the bottom of the Time Capsule, next to the serial number.

VONAGE PHONE ADAPTER

1. The WAN/MAC address is listed on the bottom of the adapter.

WIRELESS PRINTERS

In most cases, the MAC address will be located in the printer manual. However, you may need to print out a configuration page. Generic steps are below, but you may have to consult
your printer manual or support information online to determine how to print out a configuration page.

1. If there is a configuration or tools button on the front or top panel of the printer, press that button.
2. Use the arrow keys to scroll to the option for printing a test page.
3. If there is no button on the front or top panel, or if you cannot find the test page option, connect the printer to a computer using a wired connection.
4. Navigate to the printer.
5. Right-click the printer icon and select Print A Test Page.
6. In some test pages, the MAC address will print out on the page. It may also be labeled Physical Address.
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Disabling Wifi On HP Printers

Note: Some HP Wifi-compatible printers may interfere with campus wireless network activity. To keep wireless channels free of interference, follow the steps below to disable HP
wireless printer services.

For most models:

1. Use the printer menu and locate the Setup option.
2. Select Network from the options presented.
3. Select Wireless Radio on the menu that follows.
4. Switch Wireless Radio off.

HP Photosmart C4780

1. From the front panel, choose Scan
2. Scroll to locate and select Networking
3. Within the Networking menu, select Wireless to disable it.

HP Photosmart D110

1. Some models include a Wifi hardware button, requiring only that you push the button to disable wireless connectivity. The button may need to be held for up to 5 seconds. For
those models without a Wifi hardware button, follow the steps below.

1. Within the menu, navigate to Settings.
2. From the Settings menu, select Wireless, and choose Wireless Settings
3. Within Wireless Settings, select Disable Wireless and click Ok.

HP Laserjet P1102w

1. Press and hold the button shown below for 5 seconds.

2. If the indicator light turns off, the Wifi has been successfully disabled.
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Housing Staff Cable TV Support Procedure

Housing Staff Cable TV Support Procuedures

1.  If a student has a problem with their cable TV service they first contact their RA or Hall Director.

2.  If the cable jack is broken off or pushed in, RA or HD submits a service form @ www1.easternct.edu/helpdesk as aPhysically Damaged Cable TV Wall Jack  problem.

3 .   If the cable jack is physically OK, the RA or HD tests it with the test TV.

 4.  If the test TV does not show the channels, the RA/HD submits a service form @ www1.easternct.edu/helpdesk as a No Signal problem.

 5.  If the test TV does show the channel, the HD/RA refers the student back to the info sheet which reminds them how to scan the channels on their TV or determine if they have a TV
with a QAM tuner and then gives them the options for either purchasing or borrowing an external tuner.

 6.  Student's that wants to borrow a loaner QAM tuner unit must pick it up from Media Services. They must bring their ID and fill out a loan form. The unit must be returned to Media
Services it at the end of the school year (or they withdraw from Eastern.)

 7.  If after following all of these steps, the student still has problems, they can contact Media Services by email at:

mediaservices@easternct.edu.
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Wireless Printing in The Residence Halls

**New methods to print over campus wireless**

MobilePrint for printing via email, uploading, or from your mobile device.
ChromePrint for chromebook users.

**IMPORTANT - The above options are driver-less. The below options are driver based and require a package download.**

Choose the appropriate link below to install the printer for your building

Windows computers:

Burnap Hall
Burr Hall
Constitution Hall
Crandall Hall
High Rise Hall
Laurel Hall
Mead Hall
Niejadlik Hall
Noble Hall
Nutmeg Hall
Occum Hall
Winthrop Hall

Mac computers:

All dorms and public areas.
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PCs
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Mailbox selection pane

Email Quotas and Restrictions

Email Quotas and Restrictions

The following restrictions apply to faculty and staff email account:

Individual emails cannot be greater that 35 MB including attachments. Faculty and staff are restricted to less than 1000 recipient email addresses per email and 5000
recipients per day. Students are restricted to less than 300 emails a day.
Blocked file extensions: inf, ink, scf, msp, cpl, msh2xml, msh1xml, mshxml, msh2, msh1, msh, psc2, psc1, ps2xml, ps1xml, ps1, wsh wsc, wsf, ws, jse, vbs, vb, cmd, jar, hta, msi,
scr, bat, Macros, com, js, exe

If you need to email a file with one of these extensions, you must change the extension to .txt and instruct your recipient to change it back to the original once they receive it. To change a
file extension refere to the following instuctions:

Make sure you can see file exentions. If you see a period followed by two three or four letters at the end of your file name (e.g., .doc), then you can see them. If you don't see the
extension you need to turn on the ability to see them. To turn this on:

Click on My Computer.
Click on the Tools menu.
Choose Folder Options.
Click on the View tab.
Scroll down to Hide Extensions for Known File Types
Uncheck Hide Extensions for Known File Types

Locate the file you want to attach to your email.
Select it by clicking on it once (don't open it). It should be highlighted.
Press F2 (rename) on your keyboard.
Move your cursor over to the file extension and change it to .txt
Press Enter on your Keyboard

You can now safely send the attachment over email. Remember to instruct your recipient to change the extension back to the original.

Email Archiving and Managing Storage Space

Users who email large files or have long standing accounts may eventually reach a storage limit. To address this, Outlook has an
Archive feature that will free up space by archiving items older than a selected number of years. Additionally, deleted items and junk
mail are automatically archived. Archived material still appears in Outlook search results. 

To archive email, right-click any folder in Outlook, choose Assign Policy and select either the one year, three year, or five year policy.
Each of these will auto-archive items within the selected folder based on their age, archiving items older than one, three or five years
respectively. An Online Archive folder will contain the archived email, but will not count against your quota.

The Online Archive mailbox comes with a default capacity of 100 GB (in addition to your 50 GB main mailbox quota) and will
preserve the folder structure of archived items. For example, items archived from an Inbox, Deleted Items, and Junk Mail folders that
are older than five years appear in the archive folder similarly structured as shown in the image below.
 

When you search your mailbox using the search bar in Outlook, your Online
Archive will automatically be included within the results. You can find more
information about using the Online Archive mailbox folder in Outlook here: Manage email storage with online archive mailboxes -
Microsoft Support
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Installing Adobe Acrobat DC and Creative Cloud Applications

All university-owned Windows computers have the main Adobe Creative Cloud application installed, which manages the individual Adobe applications. However, due to the size, the
standard Eastern package only includes some of the individual applications. If the application you need is not on your machine, you may download and install it from the Adobe Creative
Cloud Application using the steps below.

Adobe Applications include the following:

Acrobat DC
Aero (Beta)
After Effects
Animate
Audition
Bridge
Camera Raw
Character Animator
Dimension
Dreamweaver
Ilustrator
InCopy
InDesign
Lightroom
Lightroom Classic
Media Encoder
Prelude
Premiere Rush
XD
Photoshop
Premiere Pro

Installing the Main Creative Cloud Application for Home Use Installation

If you are trying to get Adobe applications for home use, you will first need to download and install the main Creative Cloud Application from the following link and then follow the rest of
the instructions:

NOTE: These products are provided to faculty and staff at no cost to them.  If during the process, you are prompted to pay for anything, then you have made an error. 

Link to download the main Creative Cloud Application (Home Use Installation Only):  https://creativecloud.adobe.com/apps/download/creative-cloud
 

Instructions for Eastern-owned machines or home use machines after installing the main Creative Cloud Application:

1. Launch the Creative Cloud Application from your Start Menu

2. Enter your email address and choose Company or School Account when prompted

3. Enter your email address as the username and your Eastern Email password whenever prompted.

4. Click on Apps to see the list of Apps you can download and install.
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Low Battery Warning Error on a Desktop

Low Battery Warning Error on a Desktop PC

Previous instructions to remove the low battery warning also removed the automatic shut-down feature of the pc.  When you chose to shut down the pc, rather than shutting down, you'd
get a message saying, "it's now safe to shut down your pc." 

These are revised instructions to (a) turn back on the shut-down feature and (b) remove the low battery warning message.

IMPORTANT: These instructions require one or more restarts.  Please print these instructions first.

Part 1: Re-enable the Advanced Power Management Option

Go to Start.
Go to Settings.
Go to Control Panel.
Go to Power Options.
Go to the APM tab.  The enable box should be checked.  If it's not, check it. This may bring back the low battery warning message after a couple of restarts, but will also bring
back the shut down function.
Click ok and close all open windows.

Part 2: Update the BIOS

Shut down your PC.
After it's completely shut down, restart the machine, but press the F10 button (press it several times) as it's starting up. If the Windows 2000 screen comes up, you were too late
and need to shut down and try again.
You should get either a screen that says keyboard error (press F10 again to enter setup) or you will go directly into setup.
Once in setup, highlight English and press enter.
Using the arrow keys move the cursor to the right to the Power section.
Highlight Energy Saver and press enter.
Use the right arrow key to change it from Disable to Advanced.
Press the F10 key to accept.
Using the arrow keys move the cursor to the left to the File menu and highlight Save Changes and Exit.
Press Enter.
Press F10 when it asks if you are sure you want to make changes.

Your computer should re-start normally.  After it restarts, the low battery warning will be removed, and the automatic shutdown feature will be restored.
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Software Center (PC) Self Service (Mac and iOS) - How To Self-Install Programs

NOTE: These instructions are only for Eastern owned PC desktops and Mac products. If you have an Eastern owned PC laptop, please fill out the Software Request Form in
Article 221: Requesting Software Purchases and Installations in Offices, Computer Labs, and Classrooms

The Software Center is a program on your PC that allows you to receive software and updates from ITS. It enables us to keep you up to date and allows you to install certain software
yourself. Mac users have a different application for this purpose called Self Service. 

On a PC:

Click the search icon on the Windows search bar 
Start typing the words: Software Center
Click on Software Center

Select the application you would like to install from the list, and then click the Install button
The status will change to Installed once the installation is completed. You can now use your program

On a Mac and iOS:

Using the search tool   in the upper right corner, search for the Self Service application. From the search result, click the Self Service icon to launch the application.
If prompted, enter your username and password.Your username is the part of your Eastern email before the @easternct.edu, not your full email.
Locate or search for the application you want to install.
Click Install under the logo for the application
The status will change to reinstall when the installation is completed. You can now use the application.
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Recover a File or Folder Deleted from the Z-Drive

The following instructions require that you log into a Windows computer on the network at Eastern:

Go to the start menu and click on Computer.
Right-click on the Z-Drive if the file was in the main directory. If the file was in a subfolder, right-click the subfolder. 
Click Properties.
Click on the Previous Versions tab, then highlight the previous version in which you wish to pull the previous document from.
Click Open. A window will appear showing the contents of the version of that folder.
Highlight the file you want to recover.  
Right-click the file and select Copy.
Open a new Windows Explorer window.  Find the file location in which you wish to put the copied folder.  
Right-click inside the folder and select Paste.
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Workaround fix for missing OneDrive link on lectern computers

Thank you to those who reported the missing OneDrive link on the lectern computers. We are actively working to identify the source of the issue and implement a resolution.

Workaround Steps

We've identified a workaround. Here are those steps.

1) Locate the Search tool in the toolbar in bottom left hand of your screen. Start typing OneDrive.
2) Once the results start populating, find the OneDrive application icon. Click the icon to launch the OneDrive application. It might seem like nothing happens, this is expected behavior.

3) On the toolbar in the bottom right of the screen, locate the system tray chevron. Click to expand and access the system tray.
4) Once you've expanded the system tray, click the blue cloud OneDrive icon.  

5) On the resulting window, click the help and setting cog in the upper right hand corner.
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6) Click Settings. (Note if you see an Updating OneDrive message, ignore it and continue with these steps)

7) On the resulting window, click the Account tab.
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8) From the Account tab, Click Add an account.

9) Proceed with to Set up OneDrive by authenticating with your Eastern credentials. Click Sign In.
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Follow the prompts and click the blue buttons to progress through the setup. (Next, Continue & Next)

      

Once the process is complete, you should be able to access your OneDrive from the File Explorer navigation pane.
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Macs
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Enabling the Character Viewer and Phonetic Alphabet - OS X Yosemite

The newer versions of OS X hid a few key system features, including the Character Viewer and Phonetic Alphabet list item therein. Below are the steps to first enable the Character
viewer, then enable the phonetic characters, in OS X Yosemite.

Enabling the Character Viewer :

1. Go to the Apple menu and open Systems Preferences .
2. Click the Keyboard option.
3. In the Keyboard window, check the option Show Keyboard and Character Viewers in menu bar  at the bottom of the window.

The Character Viewer will now be present in the menu bar as shown below:

Enabling the Phonetic Alphabet Characters :

1. Select Show Character Viewer from the menu item shown.
2. Hold the Option key, and click the settings button in the top-left of the new window.

3. Choose Customize List from the drop down menu.
4. Scroll down and select Phonetic Alphabet as shown below:

5. Click Done.
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Keychain Access asks for keychain

Posted on September 21, 2015 by gutierrezm

Learn what to do if Keychain Access asks for your keychain password after you've changed your login password.

If you change your account's password using your Mac OS X Install disc (or if your network-based account password is changed due to a network admin forcing a password change),
your default keychain password (which uses the same initial password as your user account) does not change. Because of this, you will be prompted to enter a keychain password each
time an application requires authentication that your keychain would normally provide.Note: This doesn't happen if you change your account password using Accounts preferences.If you
want your default keychain to be unlocked automatically when you log in, synchronize your Keychain Access and account login passwords by doing this:

1.      Open Keychain Access (you can get to it by choosing Utilities from the Go menu in the Finder).

2.      From the Edit menu, choose Change Password for Keychain "login."

3.      Type the former password of the account that you are currently logged in to, then click OK.

4.      If you entered the correct password, a new window appears; enter the original password again in the Current Password field.

5.      In the New Password field, type the password that matches your current account password.

6.      Re-enter the newer password in the Verify field, then click OK.

If you don't remember your original (former) account password

If you don't remember your original password, you'll need to delete the keychain. Deleting a keychain also deletes all the password data saved in that keychain.

1.      In Keychain Access, choose Preferences from the Keychain Access menu.

2.      If available, click the Reset My Default Keychain button. This will remove the login keychain and create a new one with the password provided.

3.      If Reset My Default Keychain is not available, choose Keychain List from the Edit menu.

4.      Delete the "login" keychain.

The next time you log in to the account, you can save your current password in a keychain.
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View Only Your Account Doesn't Allow Editing on a Mac - Office 365 Error

After installing Office 365 apps on a personally owned Mac some users get an error that says:

View Only. Your account doesn't allow editing on a Mac. To learn more, contact your admin about your Office plan

This article lists possible solutions to the issue.

First verify that you are using the proper account: 

1. Click Use Another Account and sign in with Eastern email address and password
2. Alternately, click the Activate button in Word and sign in with credentials.

If that does not work, y ou can attempt to clear credential caches and reactivate office 2016 for the Mac:

You can attempt to clear credential caches and reactivate office 2016 for mac to see if there is any improvement.

1. Open finder > applications > utilities > keychain access and remove the following application passwords.
Unknown
Microsoft office identities cache 2
Microsoft office identities settings 2
search for all occurrences of adal in the keychain and remove all those entries if present. 
 

2. Open finder > click go on the top menu bar> go to folder> input the following path: ~/library/containers/
3. Right-click each of the folders below if present, and then click move to trash.

ubf8t346g9.ms
ubf8t346g9.office
ubf8t346g9.officeosfwebhost

If that doesn't work the last option is to try uninstalling office 2016 for mac completely then re-install and re-activating office 2016.
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Your Account Doesn't Allow Editing on the Mac error

Users of the desktop version of MS Excel on the Mac have issues using certain features producing the error:

View Only Your account username@easternct.edu doesn't all editing on a Mac. To learn more, contact your admin about your Office Plan.

The issue is often resolved by following the steps below:

1. Launch each Office app installed on your Mac, click on the application name (eg Word) menu and choose Sign Out. Then quit the application.
2. In the Finder, click on the Go menu and choose Go to Folder
3. In the box, type: ~/Library
4. Click on the Group Containers folder
5. Locate the following three files/folders and drag them to the Trash

UBF8T346G9.ms
UBF8T346G9.Office
UBF8T346G9.OfficeOsfWebHost

6. Empty the Trash and launch an Office application to check if you can now edit documents.

If that does not solve the problem, follow Microsoft's support guide below to remove any lingering licensing info before attempting to re-authenticate:

How to remove Office license files on a Mac (microsoft.com)

Help
Desk

52

https://support.microsoft.com/en-us/office/how-to-remove-office-license-files-on-a-mac-b032c0f6-a431-4dad-83a9-6b727c03b193


Software Center (PC) Self Service (Mac and iOS) - How To Self-Install Programs

NOTE: These instructions are only for Eastern owned PC desktops and Mac products. If you have an Eastern owned PC laptop, please fill out the Software Request Form in
Article 221: Requesting Software Purchases and Installations in Offices, Computer Labs, and Classrooms

The Software Center is a program on your PC that allows you to receive software and updates from ITS. It enables us to keep you up to date and allows you to install certain software
yourself. Mac users have a different application for this purpose called Self Service. 

On a PC:

Click the search icon on the Windows search bar 
Start typing the words: Software Center
Click on Software Center

Select the application you would like to install from the list, and then click the Install button
The status will change to Installed once the installation is completed. You can now use your program

On a Mac and iOS:

Using the search tool   in the upper right corner, search for the Self Service application. From the search result, click the Self Service icon to launch the application.
If prompted, enter your username and password.Your username is the part of your Eastern email before the @easternct.edu, not your full email.
Locate or search for the application you want to install.
Click Install under the logo for the application
The status will change to reinstall when the installation is completed. You can now use the application.
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